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Affiliated Business Disclosure and Confidentiality Agreement 
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CBRE, Inc. operates within a global family of companies with many 

subsidiaries and/or related entities (each an “Affiliate”) engaging in a 

broad range of commercial real estate businesses including, but not 

limited to, brokerage services, property and facilities management, 

valuation, investment fund management and development. At times 

different Affiliates may represent various clients with competing 

interests in the same transaction. For example, this Memorandum 

may be received by our Affiliates, including CBRE Investors, Inc. or 

Trammell Crow Company. Those, or other, Affiliates may express an 

interest in the property described in this Memorandum (the 

“Property”) may submit an offer to purchase the Property and may be 

the successful bidder for the Property. You hereby acknowledge that 

possibility and agree that neither CBRE, Inc. nor any involved Affiliate 

will have any obligation to disclose to you the involvement of any 

Affiliate in the sale or purchase of the Property. In all instances, 

however, CBRE, Inc. will act in the best interest of the client(s) it 

represents in the transaction described in this Memorandum and will 

not act in concert with or otherwise conduct its business in a way that 

benefits any Affiliate to the detriment of any other offeror or 

prospective offeror, but rather will conduct its business in a manner 

consistent with the law and any fiduciary duties owed to the client(s) it 

represents in the transaction described in this Memorandum. 

This is a confidential Memorandum intended solely for your limited 

use and benefit in determining whether you desire to express further 

interest in the acquisition of the Property. 

This Memorandum contains selected information pertaining to the 

Property and does not purport to be a representation of the state of 

affairs of the Property or the owner of the Property (the “Owner”), to 

be all-inclusive or to contain all or part of the information which 

prospective investors may require to evaluate a purchase of real 

property. All financial projections and information are provided for 

general reference purposes only and are based on assumptions 

relating to the general economy, market conditions, competition and 

other factors beyond the control of the Owner and CBRE, Inc. 

Therefore, all projections, assumptions and other information 

provided and made herein are subject to material variation. All 

references to acreages, square footages, and other measurements 

are approximations. Additional information and an opportunity to inspect 

the Property will be made available to interested and qualified 

prospective purchasers. In this Memorandum, certain documents, 

including leases and other materials, are described in summary form.  

These summaries do not purport to be complete nor necessarily accurate 

descriptions of the full agreements referenced. Interested parties are 

expected to review all such summaries and other documents of whatever 

nature independently and not rely on the contents of this Memorandum in 

any manner.  

Neither the Owner or CBRE, Inc, nor any of their respective directors, 

officers, Affiliates or representatives make any representation or warranty, 

expressed or implied, as to the accuracy or completeness of this 

Memorandum or any of its contents, and no legal commitment or 

obligation shall arise by reason of your receipt of this Memorandum or 

use of its contents; and you are to rely solely on your investigations and 

inspections of the Property in evaluating a possible purchase of the real 

property. 

The Owner expressly reserved the right, at its sole discretion, to reject any 

or all expressions of interest or offers to purchase the Property, and/or to 

terminate discussions with any entity at any time with or without notice 

which may arise as a result of review of this Memorandum. The Owner 

shall have no legal commitment or obligation to any entity reviewing this 

Memorandum or making an offer to purchase the Property unless and 

until written agreement(s) for the purchase of the Property have been fully 

executed, delivered and approved by the Owner and any conditions to 

the Owner’s obligations therein have been satisfied or waived. 

By receipt of this Memorandum, you agree that this Memorandum and its 

contents are of a confidential nature, that you will hold and treat it in the 

strictest confidence and that you will not disclose this Memorandum or 

any of its contents to any other entity without the prior written 

authorization of the Owner or CBRE, Inc. You also agree that you will not 

use this Memorandum or any of its contents in any manner detrimental to 

the interest of the Owner or CBRE, Inc. 

If after reviewing this Memorandum, you have no further interest in 

purchasing the Property, kindly return this Memorandum to CBRE, Inc. 

 

ALL PROPERTY TOURS SHOULD BE SCHEDULED THROUGH THE LISTING 
AGENT.  WE ASK THAT YOU DO NOT DISTURB THE ONSITE PERSONNEL. 
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PROPERTY DESCRIPTION 

Spencer Road Storage is a well built facility located in Saint Peters, 

Missouri.  This 40,785 net rentable square foot facility consists of 198  

drive-up, non-climate and 131 interior climate-controlled self storage 

units ranging in size from 5’x5’ to 20’x24’.  The 10’x24’ units offer 12 

foot ceilings which is a unique size in the area.  As of 2015 the 

property is 94.84 percent physically occupied and 84.4 percent 

economically occupied. 

Sitting on 4.01 acres, this attractive self storage facility consists of five 

single story buildings and one two story building of wood construction 

equipped with metal and composite roofs and roll up doors. One of 

the buildings offers a section of solar panels on the roof.  

Spencer Road Storage offers numerous amenities including a gated 

entrance with key code access, 24-hour video surveillance cameras, 

and wide asphalt and cement drive aisles for easy access. The new 

gate system has the option of taking payments at the keypad entry. 

This facility also has a U-Haul truck rental service. 

The property is located on Spencer Road and receives approximately 

27,010 vehicles passing by the facility on a daily basis.  There are 

approximately 159,435 people living in a five mile radius and an 

average household income of $85,869. 

The city of St. Peters is located in St. Charles County, Missouri. In 

recent years St. Peters has been voted as one of the Top 100 Best 

Places to Live in America by Money Magazine. The city is also home to 

Mid Rivers Mall, which is the largest mall in Saint Charles County. 

Located in St. Peters is the world-class St. Peters Rec-Plex, which is a 

236,000 square foot recreation and fitness complex.  

• 40,785 Net Rentable Square Feet 

• 329 Total Units 

• 94.84 Percent Physically Occupied 

• Built in 1999, Expanded in 2005 

• Drive-Up and Interior Units  

• Average Household Income of $85,869 

• U-Haul Truck Rental Service 
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PROPERTY SUMMARY 

ADDRESS: 
257 Spencer Road 
Saint Peters, MO 63376 

ASSESSORS’S PARCEL NUMBER: 2-0110-7946-00-1B 

BUILDING SIZE: ± 40,785 NRSF 

TOTAL UNITS: 329 Units 

LAND AREA: ± 4.01 Acres 

OCCUPANCY: 94.84% 

YEAR BUILT: 1999, 2005 

NUMBER OF BUILDINGS: Six Buildings 

NUMBER OF STORIES: One Two-Story & Five Single-Story Buildings 

UNIT SIZES: See Unit Mix For Details 

PARKING: See Unit Mix For Details 

STREET FRONTAGE: Spencer Road 

CROSS STREET: Mexico Road 

TRAFFIC COUNTS: 27,010 (Spencer Road) 

HIGHWAY ACCESS: Interstate 70 

ENTRY: Gated Entry with Key Code Access 

FRAMING: Metal / Wood 

EXTERIOR WALLS: Metal / Wood 

PARKING SURFACE: Asphalt 

ROOF: Metal / Composite 

FENCING: Chain Link 

SECURITY:  Video Surveillance 
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LOCATION MAP 
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AERIAL/MAP 
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PROPERTY PHOTOS 



9 Spencer Road Storage 

PROPERTY PHOTOS 
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PROPERTY PHOTOS 
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ALTA SURVEY 



Financials 
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FINANCIALS – UNIT MIX 
INSTRUCTIONS: 
1. To convert pdf to jpeg:  

Open pdf, File > Save as > Image 
> Jpeg > select location > Save 
 

2. To insert jpeg into the slides:  
Insert > Picture > select image > 
Insert 
 

3. To crop logo and header:  
Select image > Picture Tools > 
Format > Crop; Drag corners to 
desired shape, click away from 
the box  
 

Drive Up           

No. of Units Unit Type SF/Unit Rent/Unit Monthly Income Annual Income 

16 5x5 25 $35.00 $560.00 $6,720.00 

4 5x8 40 $60.00 $240.00 $2,880.00 

58 10x10 100 $96.00 $5,568.00 $66,816.00 

40 10x15 150 $148.00 $5,920.00 $71,040.00 

75 10x24 240 $192.00 $14,400.00 $172,800.00 

1 10x24 240 $198.00 $198.00 $2,376.00 

4 20x24 480 $375.00 $1,500.00 $18,000.00 

198 Total 32,520   $28,386.00 $340,632.00 

1st Floor Interior           

No. of Units Unit Type SF/Unit Rent/Unit Monthly Income Annual Income 

4 5x5 25 $53.00 $212.00 $2,544.00 

6 5x5 25 $55.00 $330.00 $3,960.00 

2 5x5 25 $58.00 $116.00 $1,392.00 

5 5x8 40 $66.00 $330.00 $3,960.00 

2 5x8 40 $69.00 $138.00 $1,656.00 

10 5x10 50 $71.00 $710.00 $8,520.00 

9 6x10 60 $83.00 $747.00 $8,964.00 

24 5x15 75 $89.00 $2,136.00 $25,632.00 

5 5x15 75 $93.00 $465.00 $5,580.00 

5 5x15 75 $105.00 $525.00 $6,300.00 

14 10x10 100 $132.00 $1,848.00 $22,176.00 

1 10x10 100 $138.00 $138.00 $1,656.00 

1 10x15 150 $156.00 $156.00 $1,872.00 

88 Total 5,820   $7,851.00 $94,212.00 

            

2nd Floor Interior           

No. of Units Unit Type SF/Unit Rent/Unit Monthly Income Annual Income 

2 5x8 40 $64.00 $128.00 $1,536.00 

20 5x10 50 $68.00 $1,360.00 $16,320.00 

18 6x10 60 $79.00 $1,422.00 $17,064.00 

3 9x10 90 $118.00 $354.00 $4,248.00 

43 Total 2,430   $3,264.00 $39,168.00 

Total 

329 Total 40,785   $39,501.00 $474,012.00 
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INCOME     2014 Income & Expense PER SF   

January - February 2015 

Income Annualized with 

Broker Adjusted Expenses PER SF 

GROSS POTENTIAL RENT     $474,012 $11.62   $474,012 $11.62 

Late, Letter, & NSF Fees     $6,273 $0.15   $9,268 $0.23 

Merchandise Sales (NET)     $488 $0.01   $2,442 $0.06 

Administration Fees     $210 $0.01   $3,144 $0.08 

Truck Rental (U-Haul)     $9,593 $0.24   $9,593 $0.24 

Insurance *     $3,576 $0.09   $5,336 $0.13 

                

TOTAL OTHER INCOME     $20,140 $0.49   $29,783 $0.73 

Gross Potential Income     $494,152 $12.12   $503,795 $12.35 

Economic Vacancy/ Collection Allowance   18.0% $85,052 $2.09 15.6% $73,957 $1.81 

EFFECTIVE GROSS INCOME     $409,100 $10.03   $429,838 $10.54 

                

EXPENSES               

Property Taxes (1)     $35,211 $0.86   $35,211 $0.86 

Insurance (2)     $6,430 $0.16   $6,430 $0.16 

Utilities & Trash (3)     $9,195 $0.23   $12,718 $0.31 

Repairs, Maintenance and Reserves (4)     $6,113 $0.15   $6,113 $0.15 

Advertising  (5)     $7,500 $0.18   $7,500 $0.18 

Salaries, Taxes, & Benefits (6)     $57,225 $1.40   $57,225 $1.40 

Management Fee (7)     $20,455 $0.50   $21,492 $0.53 

Office Supplies & Postage (8)     $6,500 $0.16   $6,500 $0.16 

Bank & Credit Card Fees (9)     $7,043 $0.17   $7,043 $0.17 

Telephone & Internet (10)     $2,905 $0.07   $2,905 $0.07 

Contract Services (11)     $6,531 $0.16   $6,531 $0.16 

Computer Expenses (12)     $1,181 $0.03   $1,181 $0.03 

Miscellaneous (13)     $2,488 $0.06   $2,488 $0.06 

                

Total Expenses     $168,777 $4.14   $173,337 $4.25 

% of EGI     41.3%     40.3%   

NET OPERATING INCOME     $240,323 $5.89   $256,501 $6.29 

                

Property Summary   $/SF Price Cap Rate $/SF Price Cap Rate 

40,785 NRSF   $90.72 $3,700,000 6.50% $90.72 $3,700,000 6.93% 

329 Units               

(1) Property Taxes are based on 2014 actual taxes. (8) Office Supplies & Postage have been adjusted by Broker from $9,154 to $6,500 in 2014.  

(2) Insurance has been adjusted by Broker to industry standards.  (9) Bank & Credit Card Fees are based on January through December 2014 expenses.  

(3) Utilities & Trash are based on January through December 2014 expenses. (10) Telephone & Internet are based on January through December 2014 expenses. 

(4) Repairs, Maintenance, and Reserves have been adjusted to $0.15/SF/Year. (11) Contract Service includes security. 

(5) Advertising has been adjusted by Broker to industry standards. (12) Computer Expenses are based on January through December 2014 expenses. 

(6) Salaries, Taxes, & Benefits are based on January through December 2014 expenses.  (13) Miscellaneous is based on January through December 2014 expenses. 

(7) Management Fee is based on 5% of the Effective Gross Income per industry standards. 

FINANCIALS – INCOME & EXPENSES 

Comments: 

* Insurance is based on 60% of what is actually being collected. 

CALL FOR OFFERS: APRIL 17, 2015 
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RENT COMPARABLES MAP 
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RENT COMPARABLES GRAPHS 
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RENT COMPARABLES GRAPHS 
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Spencer Road Storage Unit Type 5x5 5x8 10x10 10x15 10x24 Avg. Rent/SF

Total Units: 329

Occupancy: 94.84%

Year Built: 1991

Distance: Subject

A Storage Inn Unit Type *5x6 5x10 10x10 10x15 10x25 Avg. Rent/SF

Year Built: 1976

Distance: 1.77 Miles

Rent Specials: Free Lock with New Rental

U-Haul Moving & Storage Unit Type 5x5 5x10 10x10 10x15 10x24 Avg. Rent/SF

Year Built: 1999

Distance: 1.86 Miles

Rent Specials: First Month Free

Uncle Bobs Self Storage Unit Type 5x5 5x10 10x10 10x15 10x25 Avg. Rent/SF

Year Built: 1998

Distance: 1.91 Miles

Rent Specials: 50% Off 2nd Months Rent

U-Haul Moving & Storage Unit Type 5x5 5x10 10x10 10x15 10X30 Avg. Rent/SF

Year Built: 1949

Distance: 1.94 Miles

Rent Specials: No Deposit or Administration Fee

Property Amenities:  Fully Enclosed Facility, Video Surveillance, Rental Truck.

Property Amenities:  Gated Entry with Key Code Access, Video Surveillance, Wide Drive 

Aisles.

Property Amenities:  Gated Entry with Key Code Access, Video Surveillance, Wide Drive 

Aisles, Rental Truck.

Saint Peters, MO 63376

1st Floor CC

204.95 $1.13
7440 Mexico Road

Drive Up 44.95 69.95 94.95 119.95

199.00 $1.12
Saint Peters, MO 63376

1st Floor CC 44.00 68.00 141.00 164.00 - $1.41

3939 Mexico Road
Drive Up 40.00 64.00 104.00 135.00

Saint Charles, MO 63301

1st Floor CC 44.95 74.95 144.95 159.95 - $1.45

1st Floor CC

Property Amenities:  Gated Entry with Key Code Access, Video Surveillance, Wide Drive 

Aisles, Rental Truck.

Property Amenities:  Gated Entry with Key Code Access, Wide Drive Aisles.

Saint Peters, MO 63376
192.00

Rent Specials: $1 First Months Rent

4040 N Service Road

Drive Up 35.00 60.00 96.00

Saint Peters, MO 63376
Drive Up 42.00

Drive Up

55.00

3990 N Service Road

$1.13

129.00 196.00

-

50.00 90.00 $0.99

257 Spencer Road
148.00

66.00 132.00 156.001st Floor CC $1.55

*This Facility Does Not Offer Indoor Storage

*This Facility Does Not Offer Drive Up Storage

*This Facility Does Not Offer Indoor Storage

1

2

3

4

RENT COMPARABLES 
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Saint Peters Storage Unit Type *5x6 5x10 *10x8 *10x16 10x24 Avg. Rent/SF

Year Built: 1982

Distance: 2.00 Miles

Rent Specials: $1 First Months Rent

Public Storage Unit Type 5x5 5x10 10x10 10x15 10x24 Avg. Rent/SF

Year Built: 1987

Distance: 2.28 Miles

Rent Specials: $1 First Months Rent

Storage Masters Unit Type 5x5 5x10 10x10 10x15 10x25 Avg. Rent/SF

Year Built: 1999

Distance: 3.03 Miles

Rent Specials: 2nd Month Free

Property Amenities:  Gated Entry with Key Code Access, Video Surveillance, Wide Drive 

Aisles.

Property Amenities:  Gated Entry with Key Code Access, Video Surveillance, Wide Drive 

Aisles, Rental Truck.

170.00 $0.76
O'Fallon, MO 63366

1st Floor CC 61.00 83.00 119.00 152.00 - $1.58

2601 E Terra Lane
Drive Up DNH DNH DNH 126.00

- $1.60

Drive Up
Saint Charles, MO 63303

1st Floor CC 46.00 78.00 111.00 DNH

DNH 58.00 132.00 157.00 185.00

100.00 124.00

*This Facility Does Not Offer Indoor Storage

$1.07

1st Floor CC

Property Amenities:  Wide Drive Aisles, Lighting Above Doors.

101 N Service Road
Drive Up 30.00 44.00 58.00 $0.75

Saint Peters, MO 63376

3777 Veterans Memorial Parkway

5

6

7

RENT COMPARABLES 
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  ONE-MILE RADIUS THREE-MILE RADIUS FIVE-MILE RADIUS 
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O

P
U

LA
T
IO

N
 

2014 Estimated Population 9,177 60,031 159,435 

2019 Projected Population 9,205 60,553 162,590 

2010 Census Population 9,157 59,579 156,309 

2000 Census Population 9,602 60,311 145,596 

Growth 2010-2014 0.22% 0.76% 2.00% 

Growth 2014-2019 0.30% 0.87% 1.98% 

2014 Estimated Median Age 42.68 40.44 39.82 

2014 Estimated Average Age 42.18 40.10 39.56 

H
O

U
S
E
H

O
LD
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2014 Estimated Households 3,822 24,288 63,282 

2019 Projected Households 3,911 24,957 65,368 

2010 Census Households 3,634 23,142 60,298 

2000 Census Households 3,440 21,155 51,806 

Growth 2010-2014 5.20% 4.95% 4.95% 

Growth 2014-2019 2.33% 2.75% 3.30% 

2014 Est. Average Household Size 2.31 2.47 2.50 

IN
C

O
M

E
 

2014 Est. Median Household Income $66,373 $71,267 $70,950 

2019 Prj. Median Household Income $72,619 $76,488 $76,268 

2000 Cen. Median Household Income $55,311 $59,806 $58,724 

2014 Est. Average Household Income $79,280 $83,126 $85,869 

2014 Estimated Per Capita Income $33,021 $33,632 $34,082 

H
O

U
S
IN

G
 

2014 Estimated Housing Units 3,988 25,215 65,901 

2014 Estimated Occupied Units 3,822 24,288 63,282 

2014 Estimated Vacant Units 165 927 2,619 

2014 Est. Owner Occupied Units 2,923 19,716 50,708 

2014 Est. Renter Occupied Units 900 4,572 12,573 

2014 Est. Median Housing Value $176,541 $175,635 $183,090 

2014 Est. Average Housing Value $186,419 $191,816 $205,250 

DEMOGRAPHIC REPORT 
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TRAFFIC COUNTS 
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Nick Walker 

Vice President of Investments 

W + 1 909 418 2173 

C + 1 909 841 0546 

Lic. 01827268 

Nick.Walker@cbre.com 
 

CBRE © 2014 All Rights Reserved. All information included in this proposal pertaining to CBRE including but not limited to its operations, employees, technology and clients are proprietary and confidential, and are supplied with the understanding that they will be held in confidence and not disclosed to third parties without the prior written consent of CBRE. This letter/proposal is 
intended solely as a preliminary expression of general intentions and is to be used for discussion purposes only. The parties intend that neither shall have any contractual obligations to the other with respect to the matters referred herein unless and until a definitive agreement has been fully executed and delivered by the parties. The parties agree that this letter/proposal is not 
intended to create any agreement or obligation by either party to negotiate a definitive lease/purchase and sale agreement and imposes no duty whatsoever on either party to continue negotiations, including without limitation any obligation to negotiate in good faith or in any way other than at arm’s length. Prior to delivery of a definitive executed agreement, and without any 
liability to the other party, either party may (1) propose different terms from those summarized herein, (2) enter into negotiations with other parties and/or (3) unilaterally terminate all negotiations with the other party hereto. 
 
This information has been obtained from sources believed reliable. We have not verified it and make no guarantee, warranty or representation about it. Any projections, opinions, assumptions or estimates used are for example only and do not represent the current or future performance of the property. You and your advisors should conduct a careful, independent investigation of the 
property to determine to your satisfaction the suitability of the property for your needs. 

“Specializing in Self Storage Brokerage Throughout the United States” 

Trevor Roberts 

Senior Associate 

W + 1 909 418 2174 

C + 1 909 638 9648 

Lic. 01801520 

Trevor.Roberts@cbre.com 
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